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Warning and Caution 
 

DISCLAIMER OF WARRANTY 
 

Magnetek’s Electromotive Systems, hereafter referred to as Company, assumes no responsibility for improper 

programming of a drive that resulted from use of this software. This software should only be used by a trained 

technician who has read and understands the contents of this manual. Normal use of this software may result in 

the drive parameters becoming modified. Improper programming of a drive can lead to unexpected, undesirable, 

or unsafe operation or performance of the drive. This may result in damage to equipment or personal injury. 

Company shall not be liable for economic loss, property damage, or other consequential damages or physical 

injury sustained by the purchaser or by any third party as a result of the use of this software. Company neither 

assumes nor authorizes any other person to assume for Company any other liability in connection with the sale 

or use of this software. 
 

 
1. Read this user manual in its entirety before installing IMPULSE®�LINK 4.1Wireless Diagnostic System(WDS)or 

operating the IMPULSE®�G+/VG+ Series 2, IMPULSE®�G+/VG+ Series 3 , and/or IMPULSE®�P3 Series 2 

Variable Frequency Drives (VFD). 

2. DO NOT connect or disconnect wiring, or perform signal checks while the electrical power is turned ON. 

3. Improper programming of a drive through the use of this software can lead to unexpected, undesirable, or unsafe 

operation or performance of the drive. 

 

Failure to observe these and other precautions indicated in this manual will expose the user to high voltages, resulting 
in serious injury or death. Damage to equipment may also occur. 
 

 

 

 

 
NOTICE 
No patent liability is assumed with respect to the use of the information contained herein. Moreover, Magnetek is 

constantly improving its high quality product therefore, the information contained in this manual is subject to change 

without notice. Every precaution has been taken in the preparation of this document. Nevertheless, Magnetek assumes no 

responsibility for errors or omissions. Neither is any liability assumed for damages resulting from the use of the 

information contained in this publication. 
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Chapter 1 -  Introduction 
 

OVERVIE W  
 

IMPULSE�LINK 4.1 WDS is a user friendly, Windows® based, interactive drive communication software and wireless 

hardware package. It is designed specifically for wireless communication between Magnetek’s IMPULSE�G+/VG+ Series 

2, IMPULSE�G+/VG+ Series 3, IMPULSE�P3 Series 2 drives and your PC or company-wide network. 

 

 

 

IMPULSE�LINK 4.1 WDS consists of: 

 

1. A base unit consisting of a wireless modem hardwired 

to a PC or company-wide network.  

  

2. A remote unit consisting of a wireless modem; which 

is wired to your IMPULSE Drives and communicates 

wirelessly to the base unit. 

 

3. IMPULSE�LINK 4.1 WDS Software that allows 

access to all of the cranes in your facility from one 

location. As well as, a hardware key that must be 

present in the computer’s USB port to access the 

drives. 

 

 

 

 

 

 

 
The Wireless Base Unit 
Part number:  142-10266 

Description:   NEMA 4 junction box (12ギ x 10ギ) consists of a 120-volt standard power outlet, Ethernet wireless modem 

(USB is available as an option), antenna mounted to the junction box, Ethernet receptacle built-in to the junction box, and 

terminal block.  Along with the NEMA 4 junction box, is a 6ガ cross-over cable with Ethernet receptacle.  

 
 
 
The Wireless Remote Unit  
Part number:  142-10267 

Description:  NEMA 4 junction box (12ギ x 10ギ) consists of a 120-volt standard power outlet, wireless modem, an antenna 

mounted to the junction box, and terminal block.  Along with the NEMA 4 junction box, the remote unit comes with 50ガ 
of twisted shielded cable to connect the drives to the modem. 

 

Software and Hardware Key 
Part number:  144-12386 

Description:  CD containing the IMPULSE�Link 4.1 WDS software and customer’s drive profiles, and the hardware key. 
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SYSTEM REQUIREM ENTS 
 

Supported Drives  
IMPULSE�LINK 4.1 WDS supports the IMPULSE�P3 Series 2, IMPULSE�G+/VG+ Series 2 and Series 3 drives.  

Although the IMPULSE Series 2 drives are supported; a CMG5M communication board (part #140-10261) needs to be 

installed on each Series 2 drive. 

 

PC Requirements 
1. Pentium class or equivalent 500MHz processor or better 

2. 256 MB RAM or better 

3. Minimum of 100 MB free hard-disk space available 

4. Windows 98 SE operating system or better 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Network Requirements 
A customer supplied IP 

address must be provided 

for each base unit. 

Although multiple users 

(computers) may have 

access to the drives on an 

Ethernet network, only one 

person can be accessing a 

particular bay at a time. 

 

The maximum Ethernet 

cable length between 

devices is 328 feet. The 

Ethernet connector type is 

RJ-45. 
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Chapter 2 -  Installation  

SOFTWARE INSTALLATION  
The IMPULSE�LINK 4.1 WDS, consists of the hardware (Remote and Base Unit enclosures), as well as a CD containing 

the necessary software.  The CD contains:  the IMPULSE�LINK 4.1 WDS Software, Adobe Acrobat Reader™ for this 

technical manual, and the communication profiles for the IMPULSE Drives used in your specific application.  
 • To run the IMPULSE�LINK 4.1 WDS Setup, put the IMPULSE�LINK 4.1 WDS CD into your CD drive. Run 

setup.exe from the CD if it does not start automatically. 

 • Select the default choices during installation.  
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INSTALLING YOUR HARDWARE KEY 
Insert your hardware key into any USB port on your computer. Windows will detect 

the hardware and begin installing the necessary drivers. 

 
 
 
 
Select Next, leaving the (Recommended) choice selected.  Wait 

while the hardware is installed.  Windows will find the 

correct driver and install it.   

 

Click Finish to close the Completing the Found New 
Hardware Wizard dialog. 

 
 
 
 

 
 
 
 
 
Note:  If you try to run IMPULSE Link 4.1 WDS and the hardware key is not inserted into a USB port on the computer, 

you will receive the following error message.  Also, if you are running IMPULSE Link 4.1 WDS and remove the 

hardware key, the same message will appear until the key is re-inserted into the USB port. 

 
 
 
Free Updates, Patches 
Additional features and bug fixes may be available from time to time. These may be downloaded from the Magnetek 

Material Handling website at www.magnetekmh.com/mg_support_downloads-software.htm. 

 

Software Removal 
To remove the IMPULSE�LINK 4.1 WDS Drive Interface Software, open the Control Panel’s Add/Remove Programs 

dialog box, double-click the IMPULSE�LINK 4.1 WDS entry and choose Remove All from the IMPULSE�LINK 4.1 

WDS Setup dialog box. 
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IMPORTING YOUR DRIVE PROFILES 
Run IMPULSE�LINK 4.1 WDS by double-clicking the “L” icon found on your desktop.   

A splash screen will appear for a few seconds while the subsystem loads. 

 
 

Your drive profiles have been pre-configured for you and reside on the installation CD.   

To import the profiles: 

1. Select “Communication” from the Settings Menu. 

2. Right-Click on the “Communication Profiles“ Folder and select “Import From File” 

3. Browse to your CD-ROM drive, select the files and choose “Open”. 

4. There will be a profile for each drive (Crane 1 Hoist, Crane 1 Bridge, etc.) 

5. After the profiles are imported, select “OK” to save your communication profiles. 

 



IMPULSE•LINK 4.1 WDS Instruction Manual—12/01/2005 

8 

CREATING COMMUNICATION PROFILES USING THE WIZARD 

If you need to create a communication profile, there is a wizard to assist you.  In the Settings Menu, click 

“Communication”, and then “New”.  You will then see the following screen appear: 

 

Highlight the IMPULSE DRIVE, WM-E for the standard Wireless Ethernet Modem, and then click “Select”.  The wizard 

will then take you through the following four steps to set up a new communication profile. 

 Step 1:  Name, Description, Crane and Motion 

 Step 2:  Baud Rate, IP Address 

 Step 3:  Slave Address, Parity, and Channel 

 Step 4:  Finish 
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HARDWARE INSTALLATION 
 
Mounting  
Be sure that the base and remote units are mounted in a location protected against the following conditions: • Extreme cold or heat.  Use within the ambient temperature range of:  +14 oF to 113oF (-10 oC to 45oC) • Direct sunlight (not for use outdoors) • Rain, moisture • High humidity  • Oil sprays, splashes • Salt spray • Corrosive gases 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

At the bottom, left of the Base Unit enclosure is a cable grip for running the 115V control power wiring. The Ethernet 

receptacle is built in to the bottom right of the enclosure. Ethernet and control power wiring should never be run together.  

 

The typical wiring diagram for the Base Unit can be found in Appendix A. 

 

 

Wiring the Base Unit  
The standard Base Unit contains an Ethernet 

wireless modem (USB is available by special 

order).  The Base Unit has an Ethernet 

receptacle at the bottom of the enclosure.  A 

6ガ cross-over cable with Ethernet connector is 

provided with the Base Unit.  This 6ガ cross-

over cable can simply be plugged into the 

Ethernet port on a computer and then the 

opposite end can be plugged into the Base 

Unit’s Ethernet receptacle. 

 

The Ethernet field connector kit (shown 

below) provides strain relief and can be cut-

off from the 6ガ cross-over cable and 

connected to an alternative cable of desired 

length when connecting to an Ethernet switch 

or hub. 

The base and remote units should be mounted on a flat, non-flammable vertical surface using four mounting screws. 

Line of sight should be maintained from both the remote unit’s and base unit’s antennas to avoid communication 

dropouts. 



IMPULSE•LINK 4.1 WDS Instruction Manual—12/01/2005 

10 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Wiring the Remote Unit   
The Remote Unit contains two cable grips on 

the bottom of the enclosure.  It is important 

that control and serial wiring are run 

separately.  The Remote Unit comes with 50 

feet of twisted shielded cable for wiring to 

your drives. 

 

If you are connecting to IMPULSE�G+/VG+ 

Series 2 drives, each drive requires a 

CMG5M board. Connect multiple 

IMPULSE� G+/VG+ Series 2 drives, using 

terminals 1–4 on the CMG5M board as 

shown below: 

  TC1  

CMG5M    
BOARD   

CMG5M    
BOARD   

TC2  

TC2  

Shielded  

Sheath  

Connection 

Ground  
Connection 

1  

2  

3  

4  

2CN 

 RS-485 

Shielded  

Sheath  
Connection 

  

Ground 

Connection 

1  

2  

3  

4  

TC1  

2CN 

6CN  

6CN  

SW1

SW1
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Both the IMPULSE�G+/VG+ Series 3 and IMPULSE�P3 Series 2 drives have RS-485 communication built-in. Therefore, 

no option board is required on these drives. When wiring the IMPULSE�P3 Series 2 or IMPULSE�G+/VG+ Series 3 

drives the serial communication terminals R+, R-, S+, S- are located on the control interface board. 

 

 

Wiring to the Drives 
1. Locate the correct terminals (1–4 on the CMG5M board for Series 2 drives and R+, R-, S+, S- for IMPULSE�P3 Series 

2 and IMPULSE�G+/VG+ Series 3 drives). 

2. Use the twisted shielded wire provided with your Remote Unit for connecting as indicated in the table below. 

 
IMPULSE• G+/VG+  

Series 2 CMG5M Board 
Terminals 

IMPULSE• G+/VG+ Series 3 
and IMPULSE• P3 Series2 

Control Terminals 

Description Wireless Remote Unit 
Terminal Block 

1 R+ RS-485/input for parallel 

connection 

R+ 

2 R- RS-485/input for parallel 

connection 

R- 

3 S+ RS-485/output for parallel 

connection 

S+ 

4 S- RS-485/output for parallel 

connection 

S- 

TC2 IG Signal common for shield 

connection 

Shield 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

A typical wiring diagram for the Remote Unit is shown in Appendix A. 

 

 

on

SW1
TC2

1

2

3

4

CMG5

M 

BOAR

2CNTC1

CMG5M 

Board 

3. There is a dipswitch that connects a terminating resistor (approximately 100 Ohms). This resistor should be turned 

ON, for one-to-one connections or on the last drive, when multiple drives are wired in parallel. 

On the IMPULSE�G+/VG+ Series 3 drives, the 

dipswitch is labeled S1 and is located on the interface 

board, as shown to the right. Notice the ‘ON’ position 

of S1 is with the switch to the right side. 

 

 

 

 

 

 

On the IMPULSE�P3 Series 2 drives, the dipswitch is 

labeled SW2 and is located above the control 

terminals, RS shown to the right. Notice the ‘ON’ 

position SW2 is with the switch to the right side. 

Terminals R+, R-, S+, S- 

S1

On the IMPULSE�G+/VG+ Series 2 drives, this 

dipswitch is labeled SW1 and is found on the left side 

of the board CMG5M (as shown here). Notice the ‘ON’ 

position is on the left side of the switch. 
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Chapter 3 -  Navigation 
The IMPULSE�LINK 4.1 WDS Software is a Windows-based software with easy to use menus and drop-down functions.  

The user is able to access utilities for uploading/downloading parameters, comparing parameters, saving parameters to a 

file, accessing the DataLogger function and more from the easy to navigate toolbar.  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

New – Displays the controller properties dialog to create a new 

factory default parameter set, based on the drive type, software 

number, model, and kVA. 

Open – Opens or finds a file containing a parameter set for a 

specific drive type and software number. 

Save –  Saves the active file with its current file name and 

location. 

Save As –  Saves the active file with a different file name or 

location. 

Print Preview –  Shows how a file will look when you print it. 

Prin t –  Prints the active parameter set. Select Print options, in the 

Print window/dialog box. 

Properties –  Displays the properties box to view the properties of 

the active file. 

Exit – Closes this program after prompting you to save any 

unsaved files. 

Communication – Allows communication profiles to be added,

removed, edited, copied, imported and exported. 

Preferences – IMPULSE�LINK 4.1 WDS settings for access level.
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Write Flash - Allows a binary file to be written to VFD flash

memory. (FACTORY USE ONLY) 

Read from VFD - Loads all parameter values from the VFD to

memory. 

Write to VFD - Saves all parameter values from memory to the

VFD. 
 

Convert – Allows for parameter files to be converted from

one software/Flash ID to another (must be within the same

series). 

Compare Parameters - Allows for comparison of sets of

parameter files. 

Communication Test – performs a communication test with

the VFD. 

Monitor – Displays a select number of monitor parameters

(U-parameters), updated continuously. 

DataLogger – Opens the DataLogger function (described in

more detail in Chapter 5). 

Keypad Simulator – Emulates the keypad and allows for

navigating the keypad menu remotely (this is not available

unless hardwired to the keypad port). 

Show Error Log – shows the status of IMPULSE�LINK 4.1

WDS. 
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Window - Allows for easy parameter window organization when in

multiple window mode.  The functions in the Window menu such as:

Cascade, Tile Horizontally and Vertically, Minimize All, and Close

All, function just as they do in other Microsoft Windows-based

applications. 

Users Manual – Displays the User Manual. (Acrobat Reader must

be installed) 

IMPULSE LINK Help – Provides information on communication

profile settings and troubleshooting, complete Index of VFD fault

codes, and a Search function. 

Electromotive on the Web – provides a link to the Magnetek

Material Handling website. 

Check for Updates – provides a link to the download software

page of the website that offers updates. 

About - Displays the version number of this Electromotive

Systems product, copyright and legal notices. 
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Chapter 4 -  Parameter Maintenance 
 

IMPULSE�LINK 4.1 WDS software provides flexibility in programming, uploading, downloading, and saving 

parameters.    With full parameter descriptions and visual programming, modifying parameters from your computer has 

never been easier. 

 

Read from the VFD - allows you to load the parameter values from the drive’s memory.  This can be accomplished 

through the ‘VFD’ drop down menu or the ‘Read’ Icon (as shown below).     

 
 

 

 

 
 
Write to VFD - saves all parameter values from memory to the VFD.  Again, this can be accomplished via the drop down 

on the ‘VFD’ menu or using the ‘Write’ Icon as shown here. Writing to VFD may result in undesirable operation of your 

crane, causing danger, personal injury or death! To proceed with the write to VFD function you will need to accept that 

you acknowledge the warning message as shown here. Once you have checked the ‘I Accept’ button, the ‘Continue  write 

to VFD’ button will be available. 
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Modified Constant 
A parameter with blue text implies that its value is different than its default setting.  

- This list should match the modified constants list in the drive, with the exception of A1 parameters.  

 

Read-Only 
A grayed-out, highlighted parameter implies that it cannot be modified. This can happen for the following 

reason:. 

- The Access Level of the current parameter set is lower than what is needed for this specific parameter (i.e. 

Changing this parameter from the drive keypad would not be allowed with the current access level.) 

 

Over Maximum / Under Minimum 
A parameter with red text implies that its value is either greater than its maximum value or less than its minimum. 

An invalid value in the FIF file could result in this error. 

 

MODIFYING PARAMETERS 
By double clicking on the row of the parameter you would like to edit, the setting column will appear as a drop-down box, 

a text box, or a visual programming window. 

1.  Drop-down list box of parameter setting choices 

 

List box 

 
 

This will appear for list parameters. Simply select the value from the list and: 

- ENTER to accept the change 

- ESC to cancel the change 

 
2.  Text box for entering a parameter value 

 
Text box 

 
 

This will appear for numerical parameters.  

Simply type in the value of the parameter (in the base displayed) and: 

- ENTER to accept the change 

- ESC to cancel the change 

 
3.  Visual Programming Window (click once on the Visual Programming icon) 
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PARAM ETER FILE COMPARISON 
The Parameter File Comparison function found in 

the Tools drop-down menu allows for comparison 

of sets of parameter files. 

 

The “Show” drop-down allows you to compare: 

- all parameters of each file,  

- only parameters with different values,  

- or only parameters with equal values. 

 

 

 

 

 

 

 

 

 

 

 

 
 
SECURITY / PASSWORD PROTECTION  
The ‘Preferences’ drop-down menu in IMPULSE�LINK 4.1 

WDS software allows you to set the access level, username 

and password.  

 

By logging out of the Advanced mode you will be in the User 

mode. While in the User mode, the drives can only be 

monitored. Write to VFD and Reset functions are NOT 

available.  

 

 
 
 
 

This Visual Programming Window will pop-up for hexadecimal and binary parameter values.  The window 

provides the actual parameter value description, so that you won’t need to use the technical manual to translate a 

hexadecimal or binary value. Simply click the mouse on the table to modify, and then click on the “OK” box or hit 

enter to accept the change. Click the “Cancel” box or ESC to cancel the change. 

 

NOTES: 

1. If a change is made, ENTER is not pressed to accept it, and the user clicks on another row or column, the 

value will revert back to what it was before the change. 

2. If a parameter is changed to an invalid value, under the minimum value or over the maximum value, an 

appropriate message will be displayed and the value being edited will revert back to what it was before the 

change. 
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Chapter 5 -  Monitor / DataLogger Function 
 

MONITOR  
 

 

  
 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There is a ‘Monitor’ function in the ‘Tools’ 

drop–down, which displays a select number of 

monitor parameters (U-parameters) that are 

continually updated. 

DATALOGGER  

Although the DataLogger function also 

provides monitoring, it is primarily for 

troubleshooting of your 

IMPULSE�G+/VG+ Series 2 and Series 3 

drives.  The DataLogger function allows 

easy access to the Run, Alarm, and Fault 

histories.  Past events are logged:  Last 

1400 Run Events, Last 200 Alarm Events, 

and last 200 Fault Events.   

 

A Trace function allows for viewing drive 

data that lead to the Alarm and/or Fault 

condition. 

 

DataLogger files containing the logged 

events and trace data can be saved, printed, 

and emailed for additional troubleshooting 

assistance. 

 

If a Fault or Alarm condition occurs, the 

DataLogger allows you to click on the 

Alarm or Fault, and displays 

troubleshooting information (as shown 

here). 

 

 

NOTE: The DataLogger function does not 

support IMPULSE�P3 Series 2 drives. 
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FAULT RESET 
In the event of a fault condition, you will see the fault icon on either 

the DataLogger window or the Monitor window as indicated below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can reset a fault in the Monitor window or DataLogger window, 

as long as the drive doesn’t have a Run command and the fault 

condition no longer exists.  Once you click on the fault reset icon (as shown above), 

a warning message will prompt you to accept that you acknowledge 

the warning.  When resetting a drive remotely, you need to be sure 

that all personnel and/or operators are notified.  Once you have checked 

the “I accept” box, the “Continue Fault Reset” button will be available. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fault Icons 

Fault Reset Icons 
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Chapter 6 -  Additional Menu Features 

PRINT PREVIEW 
IMPULSE�LINK 4.1 WDS provides a compact printing mode that displays all drive parameters in only 1-2 pages. It also 

prints a more detailed mode that lists descriptions as well as units for each parameter. 

 

Compact Parameter Print Preview 

 
 
 

 

 

 

 

Print 

 
 

NOTE: Only parameters that are viewable in the  
Parameters Window will be printed. 
 

 

Detailed Parameter Print Preview 

Prin ter Name – Allows the user to select from any printer installed

on his/her system. The user’s default printer is initially selected. 

Print Mode - Allows the user to choose the printing style.  

o Compact mode (1-2 pages) provides parameter name and setting

value.  

o Detailed mode provides parameters, descriptions, setting, values

and units as well as ‘modified’ information. 

o As shown prints all of the information as shown on the screen. 

OK Button – Prints the active parameter set to the selected printer in

the chosen format.  
Cancel – Closes this dialog box without printing. Changes to

Customer Name, Application and Job Number are not saved. 

 
Text placed in the Customer Name, Application and Job Number
fields appear on the printout. 
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PARAMETER FILE CONVERSION   
‘Convert’ under the ‘Tools’ menu allows for parameter files to be converted from one software/Flash ID version to 

another (within the same drive series).  

 

 

 

 

 

 

 

 

 

   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Digital Operator Emulator NOTES:  
 

1. To Activate, Select the correct drive profile from the dropdown and 

click the w button. 

2. The Keypad will automatically close if any communication function, 

such as Upload and Download, or a new offline parameter set is created 

from the Controller Properties window. 

3. The RUN command has been disabled for safety reasons. 

4. If the drive is put into “Program Mode” and not returned to “Run 

Mode”, the user will be unable to run the drive. 
 

Source – Specifies the file to be converted. 

 

Flash ID – Specifies the software type that the 

file will be converted to. 

 

Destination Filename – Specifies the 

Destination filename.  

 

Convert - Converts the parameter file specified in 

“Source” to the format specified in the software 

version in the Flash ID. The converted file is 

saved to the filename and path specified in 

“Destination Filename”. 

Keypad Simulator – The keypad simulator emulates the P3 

Series 2 or Series 2 or 3 keypad which allows for remote keypad 

menu navigation. This function is only available when 
IMPULSE• LINK 4.1 WDS is connected via the drive’s keypad 
1CN connector (instead of the standard RS485 connection) – 
primarily for training purposes.  If you attempt to run the keypad 

simulator while connected via the standard RS485 connection a 

CF00 Comm Error will occur. 
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VIEWING PARAMETERS 
The ‘View’ drop-down box allows you to select how the parameters are viewed, as shown below   

(all, modified, or another sub group).  

 

 
 

 

 

 

 

 

 

 

 

Copy & Paste-   
The copy & paste function works just like a 

Microsoft Windows application. You can 

highlight multiple rows and/or columns using 

either the ‘shift’ key or your mouse and then 

right click to either copy or print that 

highlighted area.  If you selected ‘copy’ 

when the area is highlighted, you can then 

open another Windows application and paste. 
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Chapter 7 -  Troubleshooting 
 

In the Troubleshooting section of 

the IMPULSE�LINK 4.1 WDS Help 

Menu, you can select either Drive 

Fault References or Error 

References. The Drive Fault 

References provide the fault code, 

description and corrective action for 

all of the G+/VG+ Series 2 and 

Series 3 faults and P3 Series 2 faults. 

Therefore, you will not need to 

consult your technical manual when 

you have IMPULSE�LINK 4.1 WDS 

running. The Error References are 

communication errors that could 

occur while running IMPULSE�LINK 

4.1 WDS. 

 

 

 

 

 
Drive Faults References- IMPULSE�LINK 4.1 WDS offers built-in Help screens for the drive faults and/or alarms.  

The Help screens provide advanced diagnostics allowing you to troubleshoot your drive from your PC.  When you ‘click’ 

on the fault, the help screen provides the fault code, fault name/description, and the corrective action.     
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Or you can simply go to the Help Icon and go to the Drive Fault References for a complete list of P3 Series 2, G+/VG+ 

Series 2 and 3 drive faults, as shown below: 

 

 
 
COMMU NICATION ERROR REFERENCES 
The Help function provides an overview of the possible errors that could occur while running IMPULSE� LINK 4.1 

WDS, as shown here: 
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By clicking on the type of error, you will be provided the fault code with description and correction action.  

  

 
 
 

COMMUNICATION PROFILE TEST   
The Communication Profile Test Utility provides a loop 

back test to the drive to determine the status of  

communication.   This function is found in the Tools 

drop-down menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Show Error Log - This function also found in the Tools drop-down

menu, brings up an additional window showing the status of

IMPULSE�LINK 4.1 WDS. 
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Appendix A:  Typical Wiring Diagrams 
 

Typical Wiring of Base Unit 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Typical Wiring of Remote Unit 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 


